
 1 

Human Brain Microvascular Endothelial Cells Resist Elongation Due to Shear Stress 

 

Adam Reinitz,# Jackson DeStefano,# Mao Ye, Andrew D. Wong, and Peter C. Searson* 

 

1Department of Materials Science and Engineering, Johns Hopkins University, 3400 North 

Charles Street, Baltimore, MD 21218, USA 

2Institute for Nanobiotechnology Johns Hopkins University, 3400 North Charles Street, 

Baltimore, MD 21218, USA 

#contributed equally 

 
 
Supplementary Video 1.  A confluent monolayer of HBMECs under a shear stress of 16 dynes 

cm-2 for 36 hours after 6 hours pre-conditioning.  Area is 1.5mmx 1.2mm. 

Supplementary Video 2.A confluent monolayer of HUVECs under a shear stress of 16 dynes 

cm-2 for 72 hours after 6 hours pre-conditioning.  Area is 1.5 mmx 1.2 mm. 
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1.Verification of flow profile 

To verify the flow profile in the microfluidic channels, fluorescent beads (Fluospheres, 2.0 μm, 

red, Invitrogen) were injected into the flow system. After the beads had dispersed throughout the 

system a series of videos were taken.  Videos were recorded in 50 μm increments, starting from 

the height of the cell monolayer and continuing to the top of the channel. Each video consisted of 

~140 frames which covered a time of about 9 seconds, or the period of our peristaltic pump. 

Each frame is taken at either 4ms or 6ms exposure time and consists of numerous lines, 

representing flowing beads, some in focus and some out of focus(Figure S1).  In order to 

calculate the velocity of the beads, each line that is in focus is traced.  This gives the length in 

pixels of the lines in focus as a function of time.  Since the scale of the image is 0.64 

microns/pixel and the exposure time for each image is known, a velocity can be extracted from 

the length of these lines. By tracing frames along the entire period of the peristaltic pump for 

each height we were then able to compose a velocity as a function of time graph (Figure S2a), 

showing how the velocity of the flow changes along the period of the pump. Once those numbers 

were obtained we can then take the min, max, and time average velocities at each height and 

show velocity as a function of height (Figure S2b), giving us the flow profile.   

 

 

Figure S1. Sample image of fluorescent beads flowing through the 4 dyne cm-2 channel 
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Figure S2. (a) Plot of velocity versus time at a height of 150 µμm above the cell monolayer in the 

4 dyne cm-2 channel.  This plot demonstrates the peristaltic flow with a period of ~9s.  (b) Plot of 

channel height versus velocity, with the expected parabolic shape.  The curves shown represent 

the maximum, minimum, and time average velocity at each height. 
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2. Analysis of time lapse videos 

The first step to analyze the time lapse video is to select the frames that are going to be analyzed 

and export them as a series of .tif images. We select an image every six hours throughout the run, 

and the images are exported in a mono-image format. To analyze the selected frames an ImageJ 

macro is used that traces each individual cell and outputs relevant statistics. The macro is run on 

each frame, generating data that describes how the monolayer changes as a function of time and 

shear stress. All the data is then compiled in an excel spreadsheet in order to visualize the trends.  

 

 

 

 

Figure S3. Overlay of the skeleton output from the cell tracing macro over the original phase-

contrast image. 

 

3.Verification of morphological parameters from time-lapse videos 

To verify that our ImageJ macro accurately traces cell-cell boundaries, immunofluorescence 

images of ZO-1 borders were hand traced and compared to the results from the macro. The 

results from this comparison (Table S1) indicate that the macro is sufficiently accurate in tracing, 

with a maximum error of 7.3% in the 12 dyne cm-2 area parameter and an average error across all 

parameters of 4.7%. By increasing the number of cells hand traced this error may be reduced, but 



 5 

this sample size was sufficient for the verification purposes. A second, more qualitative method 

was also employed to further verify the computer traces.  To be specific, when the ImageJ macro 

runs a skeleton is saved, which is a mask of all the cells traced. Using Adobe Photoshop, this 

skeleton is layered on top of the original image that was traced. By reducing the opacity of the 

skeleton, it is possible to see the mask of the traced cells over the image (Figure S3) of the cell 

monolayer and, therefore, visually confirm that the trace is accurate. 

 

 

shear stress 8 dyne cm-2 12 dyne cm-2 
method IHC macro IHC macro 

N 494 4589 488 863 
Area 1160 ± 27 1090 ± 8 1270 ± 7 1370 ± 25 
Orientation 19.4 ± 0.5 18.5 ± 0.2 19.4 ± 0.5 19.4 ± 0.4 
IAR 0.25 ± 0.003 0.26 ± 0.001 0.25 ± 0.003 0.27 ± 0.002 

 

Table S1. Comparison of morphological parameters for HBMECs obtained from our automated 

ImageJ macro (macro) and from manual tracing of ZO-1 cell borders in fluorescence images 

(IHC).  HBMECs were exposed to a shear stress of 8 dyne cm-2 or 12 dyne cm-2 for 36 h.  

Parameters are expressed ± SE. 
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4.  Particle Image Velocimetry 

The OpenPIV application was used to analyze the motility of cell monolayers exposed to shear 

stress.  This application has several parameters that can be selected to optimize either the 

resolution or run time.  In order to validate the robustness of the application, each of these 

parameters was adjusted to determine its influence on the output data.  Data are presented here 

on the effect of the interrogation window, the spacing/overlap, the size of the region of interest 

(ROI), and time difference between successive images.  The S/N parameters were tested but did 

not alter the output data.  The scale parameter does not affect the analysis and, therefore, was 

also omitted from the validation.  The results reported here are unfiltered, meaning points that 

were outliers were not filtered out, and therefore the outlier filter is not important for 

consideration here.  The jump parameter allows comparison of each image to an image further 

along in the image sequence, smoothing data, while preventing analysis of several final time 

points.  In order to analyze the entire experiment, the jump parameter was left at 1 for the 

motility analysis. 

 

 

 

Figure S3. Screenshot of the OpenPIV GUI, with analyzing parameters listed (right) and a 

sample ROI outlined by the yellow box 
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 The results from the validation experiments (Figure S4) indicate that changing any of these 

parameters does no significantly change the observed motility.  Reducing the size of the ROI 

(Figure S4a) slightly increases the noise in the data, but the output data continues to fluctuate 

around a value of 0.2.  Since increasing the ROI significantly slows the program down, the 

motility analysis was performed with an ROI containing a quarter of the full image.  Increasing 

the size of the interrogation window (Figure S4b) increases the apparent noise in the data.  Since 

the interrogation window determines the area within which the program will look for the next 

location of each point, it is likely that with larger interrogation windows large, outlier jumps will 

be included in the data.  Increasing the interrogation slows the program even more significantly 

than the high ROI, and, therefore, a 32x32 pixel interrogation window was chosen for the 

motility analysis.  Varying the time between images (Figure S4c) causes a smoothing of the data, 

but does significantly change the average PIV recorded.  For the full experiments, time-lapse 

images are captured every 20 min and, based on these results, this imaging frequency is 

sufficient to capture the motility trends as a function of time. Reducing the space between 

analyzed points (Figure S4d) increases the number of data points collected for each image.  This 

does not appear to significantly alter the output data and, for spacing below 32x32 pixels, 

reduced spacing causes the program to run extremely slow.  For this reason, the spacing/overlap 

was set to 32x32 pixels.  None of the parameters significantly affected the output and, therefore, 

the settings were chosen to maximize the speed of the program without sacrificing the resolution 

of the resulting data. 
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Figure S4. Plots of motility data from adjusting (a) the ROI, (b) the interrogation window, (c) 

the time between images, and (d) the spacing/overlap between analyzed points. 
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Comparison of PIV to analysis of individual cells 

To determine how well the PIV measurements represent individual cell speed, we traced 

individual cells 

 

 
Figure S5.  Average cell speed for HUVEC cells in endothelial basal media under 4 dyne cm-2 

shear stress for 72 h (N = 4) determined by individual cell tracking.  To track an individual cell, 

the x,y location of the cell nucleus was identified in each frame and the cell speed calculated 

from the displacement. The time dependence of the cell speed is qualitatively the same as the 

PIV measurement (Figure 5b), however, the magnitude of the cell speed is about two times 

higher than for the PIV measurements. 
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5. Influence of growth factors on cell morphology and cell speed  

 
Figure S6. Morphology and speed of HUVECs in confluent monolayers exposed to a shear 

stress of 4, 8, 12, and 16 dyne cm-2 in basal media containing growth factors.  (a) Inverse aspect 

ratio (IAR), (b) average angular orientation (θ), (c) average cell area (A), and (d) average cell 

speed.  The average speed was determined using the PIV algorithm (see Materials and Methods) 

in basal media with growth factors.  Data were obtained from analysis of images from time-lapse 

videos at 20 minute intervals. These results suggest that the presence of growth factors does not 

significantly influence cell morphology and cell speed.   
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6. Analysis of f-actin filament orientation 

Fast Fourier transforms of 884 µm x 884 µm images (900 pixels x 900 pixels) were obtained 

using the FFT2 routine in MATLAB.  The reciprocal space intensity distributions for HBMECs 

and HUVECs at 8, 12, and 16 dyne cm-2 are shown in Figure S7.  The radial intensity 

distributions are obtained by integrating the intensity in 10˚ increments (Figure S8). 

 

 
 

Figure S7.  Fast Fourier Transform images showing the distribution of fluorescence intensity in 

reciprocal space, with the zero-frequency pixel in the center.   Fourier transforms were 

performed on 884 µm x 884 µm images (900 pixels x 900 pixels).  Orientation data for each 

condition are calculated by averaging the intensity distribution of three transform images 

obtained from different locations in the channel.  Brightness and contrast adjustments were made 

uniformly to each of these image.   
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Figure S8. Radial intensity distributions of actin filament alignment from -90˚ to 90˚.  Each 

graph corresponds to the associated transform image in Figure S7.  The parallel indices were 

obtained from the intensity in the range 0 ± 10˚ and the perpendicular indices were obtained from 

intensities in the range 90 ± 10˚ bins. 

 

To verify the robustness of the F-actin quantification program, validation experiments were 

conducted to confirm the consistency and tolerances of the protocol. Validation experiments 

were designed to determine how varying the image size, the image resolution, and the region 

imaged would affect the results obtained.  Fluorescence images of HUVECs exposed to 16 dyne 

cm-2 for 72h and stained for F-actin were chosen for the validation because these cells showed 

the most significant variation from a random distribution and, therefore, would be expected to 

show more discernible changes when varying these parameters. 

 Results from varying the image size (Figure S9) indicate that reducing the image size 

increases the variability of measurements between images but does not significantly alter the 

average value, with measured values for actin parallel to flow of 21.7% ±.2% when analyzing the 

complete image and 20.7% ± 1.6% when analyzing 1/64 of the image.  Similarly, the actin 

perpendicular to flow was recorded as 6.36% ± .06% when analyzing the full image and 6.77% ± 
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.09% when analyzing 1/64 of the image.  The data reported in this paper is the average analysis 

of 3 full size images, each containing more than 500 cells. 

 

 

 

Figure S9. Influence of image size on fraction of oriented filaments.  A 900 x 900 pixel (884 µm 

x 884 µm) image was used for analysis.   (a) Parallel and (b) perpendicular index for different 

fractions of the full image analyzed. 

 

 

 Results from decreasing the image resolution (Figure S10) indicate that reducing the 

resolution by up to a factor of 8 does not significantly alter the measured values with values for 

percent actin parallel to flow of 21.8 at full resolution, 21.4 at 1/3 resolution, and 19.8 at 1/8 the 

resolution.  Similarly, the percent actin perpendicular to flow was measured as 6.3 at full 

resolution, 6.2 at 1/3 resolution and 6.7 at 1/8 resolution.  This data was based on a single image 

containing more than 500 cells. 

 Images were taken from three separate regions within the channel to confirm consistency 

between images.  The measured values for actin parallel at these three locations were 21.8%, 

21.2%, and 22.0%. The measured values for actin perpendicular at these three locations were 

6.3%, 6.5%, and 6.2%.  These results indicate that the program measured actin fibers to be 

consistently non-random throughout the channel. 
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Figure S10. Plots of the percent of actin parallel (left) and perpendicular (right) to the direction 

flow versus the relative resolution, as compared to the uncompressed (full) image. 
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7. Macro for morphological analysis of time-lapse videos 

To quantify the morphological parameters of HBMEC and HUVEC monolayers we use a custom 

imageJ macro, CellTracer. CellTracer traces individual cells in a phase contrast image of a 

confluent monolayer and outputs the area, orientation angle, and inverse aspect ratio for each cell 

traced.  The code for the macro is provided below: 

fpath	
  =	
  "/C:/imageStack/";	
  //Define	
  File	
  Path,	
  specifies	
  the	
  location	
  of	
  the	
  sequence	
  of	
  .tif	
  
images	
  
i=3;	
  //Naming	
  the	
  number	
  of	
  the	
  image	
  in	
  the	
  set,	
  defines	
  the	
  xy-­‐position,	
  to	
  be	
  changed	
  to	
  
chage	
  which	
  image	
  to	
  analyze	
  
thresh=100;//lower	
  bound	
  value	
  for	
  setThreshold()	
  
run("Clear	
  Results");	
  //Empty	
  the	
  results	
  table	
  
	
  
//Image	
  Processing	
   	
  
	
   run("Enhance	
  Contrast",	
  "saturated=90");	
  //Increase	
  contrast	
  
	
   for	
  (j=0;j<10;j++){	
  
	
   	
   run("Smooth");	
  //Smooths	
  edges	
  between	
  the	
  cell	
  body	
  and	
  border	
  
	
   }	
  
	
   setAutoThreshold("Default	
  dark");	
  	
  //Applies	
  threshold	
  to	
  set	
  any	
  not	
  black	
  regions	
  as	
  
background	
  
	
   setThreshold(thresh,	
  255);	
  //sets	
  threshold,	
  vary	
  first	
  number	
  to	
  optimize	
  image	
  
analysis,	
  may	
  be	
  necessary	
  to	
  comment	
  out	
  
	
   run("Convert	
  to	
  Mask");	
  //	
  Converts	
  the	
  thresholded	
  image	
  to	
  a	
  binary	
  mask	
  
	
   run("Convert	
  to	
  Mask");	
  //	
  Inverts	
  black	
  and	
  white	
  on	
  the	
  mask	
  
	
   run("Fill	
  Holes");	
  
	
  
	
   run("Analyze	
  Particles...",	
  "size=300-­‐Infinity	
  circularity=0.00-­‐1.00	
  show=Masks	
  display");	
  
//Removes	
  particles	
  smaller	
  than	
  this	
  lower	
  bound	
  
	
   run("Find	
  Maxima...",	
  "noise=10	
  output=[Segmented	
  Particles]	
  light");	
  //Applies	
  
algorithm	
  to	
  expand	
  cells	
  to	
  fill	
  the	
  image	
  area	
  
	
   run("Clear	
  Results");	
  //Removes	
  results	
  from	
  analyze	
  particles	
  
	
   run("Analyze	
  Particles...",	
  "size=700-­‐16000	
  circularity=0.00-­‐1.00	
  show=Masks	
  display	
  
add");	
  //Analyzes	
  the	
  expanded	
  cells	
  
	
   	
  
//Preparing	
  location	
  to	
  save	
  the	
  traced	
  monolayer	
  
	
   File.makeDirectory(fpath	
  +	
  "skeleton");	
  //Creates	
  folder	
  to	
  save	
  monolayer	
  trace	
  
	
   fsave	
  =	
  fpath	
  +	
  "skeleton/"	
  +	
  "seg"	
  +	
  iname;	
  //Create	
  file	
  for	
  monolayer	
  trace	
  
	
  
//Save	
  monolayer	
  trace	
  
	
   selectWindow("Mask	
  of	
  "	
  +	
  iname);	
  close();	
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   selectWindow(iname);	
  close();	
  
	
   selectWindow("Mask	
  of	
  "	
  +	
  iname	
  +	
  "	
  Segmented");	
  	
  
	
   saveAs("Tiff",fsave);	
  //	
  Saving	
  skeleton	
  
	
   close()	
  

 

USER MANUAL 

Image Acquisition & Export 

(1) Take time-lapse images of a uniform monolayer of endothelial cells.  We typically collect 

phase-contrast images on an inverted microscope (Nikon Instruments) with a 10x objective every 

20 min using a 14-bit grayscale camera and automated image acquisition software (NIS 

Elements).  Select frames for analysis. 

(2) Export images as grayscale tif files to be analyzed using ImageJ (NIH, Bethesda, MD). 

Image Analysis using ImageJ  

(1) Open ImageJ (Figure 1).  

(2) Import time-lapse images as an image stack: File>Import>Image Sequence...  

(3) Open the ImageJ macro for editing: Plugins>Macros>edit... 

(4) Optimize threshold variables.  

 (a) ‘thresh’ 

• thresh is an integer value used in the "setThreshold" method. This variable should 

contain an 8-bit value, between 0 and 255.  This value is optimized for one or more 

images to enhance the borders between cells when converting the images to binary.    We 

manually check the resulting binary image for discrete borders and iteratively adjust the 

number for improvement; our values typically range from 60 to 150. 

• In Figure 2, three different traces are shown each having a different threshold value.  At 

the optimal value, 110 in this case, all the cells are recognized and traced (Figure 2b). If 

the thresh is too high, 130 in this example, the macro recognizes particles that are not 

cells which causes errors in the trace (Figure 2a). Similarly if the threshold is too low the 

macro does not recognize all the cells leading to errors in the trace (Figure 2c). 
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(b) There is a saturated value for the “Enhance Contrast” at the beginning of the image 

processing block that can be changed but the best results are obtained at a value of 90. 

(c) There is also a loop of smooth methods run after the “Enhance Contrast” method and the 

number of iterations can be change but the best results are obtained at a value of 10. 

(d) For the analyze particles method there is an upper and lower bound particle size which 

determines which particles get expanded. The lower bound is set at 200 pixels. This 

number has some room to change if there are smaller cells, but by decreasing the lower 

bound there is an increased possibility of expanding a particle that is not a cell.  The 

upper bound is set to infinity. 

(e) There is also a second iteration of analyze particles that analyzes the traced cells to see if 

there are any errors. There is a size field that can be modified which tells the program 

which cells to exclude, if any, based on being either too small or too large to be a cell. 

(5) Select relevant parameters (Area, Center of mass, Perimeter, Shape descriptors, etc.) to be 

measured: Analyze -> Set Measurements (Figure 3). 

(6) Save and run macro (Ctrl + S, Ctrl + R) (Figure 4). 

(7) All relevant data is stored in the results table using Export/save data (Figure 5). 

 

 

 

Figure 1 
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Figure 2 
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Figure 3 
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Figure 4 
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Figure 5 


